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Single-Axis WaveCatcher Components 
 
♦ Carrying Case 

♦ Analog-to-digital conversion module (A/D module) 

♦ Netbook Computer 

♦ Single-axis Accelerometer Head 

♦ V-block 

♦ PCB Piezotronics Testing Microphone 

♦ USB Type B-to-USB Type A cable 

♦ BNC-to-two pin cable 

♦ Computer power cable 

♦ BNC-to-BNC cable 

♦ Manuals and Certifications

Netbook Computer A/D Module Microphone 

Cables V-block Accelerometer Head 
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Setting Up 
 

1. Connect power cable to netbook computer.  Plug in to wall outlet.  Open computer and 
turn on by pressing Power button. 

2. Connect the A/D module’s USB Type B output to the computer’s USB Type A input 
using the USB cable.  

3. Launch the WaveCatcher software using the icon on the desktop or via the icon on the 
start menu. 

 

QUICK START:  Running a Vibration Test 
 

1. Remove accelerometer head from WaveCatcher case.  Connect the accelerometer head to 
Input 1 of the A/D module using the BNC-to-two pin cable.  Place the accelerometer 
head in the desired testing location with the flat side resting on a flat surface.   

CAUTION: The accelerometer head is very sensitive.  Avoid rough handling or dropping 
the head.   

2. Using WaveCatcher software, load a testing QuickSet (see Using QuickSet section, Page 
7) or configure custom testing parameters.  A QuickSet for testing acceleration has 
already been configured and can be accessed through the Load Settings option on the 
QuickSet menu. 

3. Make notes regarding test in Run Notes section. 

4. Press Start to run a test. 

5. The duration of the test will depend on the number of averages selected.  It is 
recommneded to do at least ten averages per test.  You will see the averages counting up 
in the Averages box.  You can stop the test before it completes the specified number of 
averages by pressing Cancel.  The test data will not be automatically saved if you press 
Cancel, but you can save the data manually using the instructions below. 

6. The test will automatically stop upon taking the specified number of averages.  The data 
will automatically be saved to a .CSV file.  A dialog box will appear displaying the file 
name that the data was saved to.  Press OK to continue.  (See Saving the Data section, 
Page 5, for other Save options.) 

7. Repeat steps 4 through 7 to conduct additional tests. 

8. Place accelerometer head sideways in V-block to conduct testing of horizontal axes.  
Make note of acceleromter orientation in Run Notes. 
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QUICK START:  Running an Acoustic Test 
 

1. Remove microphone from blue case.  CAUTION: The microphone head is very sensitive.  
Avoid touching the tip of the microphone. 

2. Connect the acoustic microphone to the Input 1 BNC connector on the A/D module using 
BNC-to-BNC cable.   

3. Using WaveCatcher software, load a testing QuickSet (see Using QuickSet section, Page 
7) or configure custom testing parameters.  A QuickSet for testing sound pressure in 
Pascals has already been configured and can be accessed through the Load Settings 
option on the QuickSet menu. 

4. Adjust the settings and display functions as desired in the Run Control pane (see below 
for additional details).  Add relevant testing details in the text field.  Set the desired 
number of averages to take in your test.  We recommend taking at least ten averages for a 
site survey. 

5. Place the acoustic microphone in the desired testing location.  Make notes regarding test 
in Run Notes section.  Make note of orientation of the microphone. 

6. Press Start to run a test. 

7. The duration of the test will depend on the number of averages selected.  You will see the 
averages counting up in the Averages box.  You can stop the test before it completes the 
specified number of Averages by pressing Cancel.  The test data will not be automatically 
saved if you press Cancel, but you can save the data manually using the instructions 
below. 

8. The test will automatically stop upon taking the specified number of averages.  The data 
will automatically be saved to a .CSV file.  A dialog box will appear showing the file 
name that the data was saved to.  Press OK to continue.  (See Saving the Data section, 
Page 5, for other Save options.) 

9. Repeat steps 5 through 8 to conduct additional tests. 
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Saving the Data 
There are three methods to save test data: 
 
Auto Save:  Upon completing a test, a .CSV file with the data will automatically be saved to the 
WaveCatcher folder in My Documents. 

Save Bitmap:  This will save a bitmap (.BMP) image of the graph as it is currently configured, 
including input labels.  Access the File menu and select Save Bitmap.  Choose the destination 
folder and the file name you would like to save to. 

Save Data: This will save a comma-seperated values (.CSV) file of the data which you have 
taken in the current test.  Access the File menu and select Save Data.  Choose the destination 
folder and the file name you would like to save to. 

Copy:  This will copy a bitmap image of the current test to your computer’s clipboard.  Access 
the Edit menu and select Copy.  Access the document (for example, a Word file) into which you 
would like to insert the image, access the Edit menu, and select Paste. 

 

Using the Data 
 
The .CSV files can be opened and manipulated using any spreadsheet program.  OpenOffice.org 
Base is already installed on the computer as the default spreadsheet program.  Use File Explorer 
to access the .CSV file.  The data files can also be accessed throught the Open function in any 
spreadsheet program. 
 
The .BMP files can be viewed using any image viewer program. 
 

Run Control 
 
Start Button:  Starts the test.  Click on this button to start taking data. 
 
Cancel Button:  Cancels the test currently running.  If the test is cancelled, data will not be 
automatically recorded for that test.  You may save the data set manually or simply move on to 
the next test. 
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Units:  Determines in what units the data will be displayed and recorded.   
 V – volts 
 g – g’s represent acceleration divided by Earth’s gravitational pull 
 m/s^2 – meters per second squared 
 m/s – meters per second 
 m – meters – measure of displacement 
 inch/s^2 – inches per second squared 
 inch/s – inches per second 
 inch – inches – measure of displacement 
 
Start Frequency:  Determines the minimum frequency for which data will be recorded.  The 
minimum allowable frequency is 1 Hz. 
 
Stop Frequency:  Determines the maximum frequency which data will be recorded.  The 
maximum allowable frequency is 5000 Hz. 
 
Averages:  Determines the number of samples that will be taken in the test.  The data will be 
averaged across the number of samples.  It is recommended to take AT LEAST 10 averages per 
test. 
 
Window:  Allows you to choose the type of FFT filter applied to the data.  You can choose 
between Rectangular and Hanning.  Hanning is more common for use in site surveys. 
 
Run Notes:  Enter notes on each test here.  The notes will be saved with the test data.  Important 
information regarding the test should be recorded here.  Common examples of run notes include 
date and time, location, and units. 
 
Input Settings 
You can manipulate several display and recording settings for each Input.  Toggle between the 
three inputs by clicking the tabs at the top of the Input settings pane.  NOTE: Changing a setting 
for one Input will not automatically change the setting for the other inputs. 
  
Show:  Adds or removes a given input’s trace on the display graph and the input’s data in the 
data set.  Unchecking the box will remove the input’s trace from the display graph and will 
remove the input’s data from the data set. 
 
Cursor:  Adds or removes a cursor from the input’s trace in the display graph.  The cursor can 
be moved to pinpoint certain data points on the input’s trace.  The Cursor can be moved by 
clicking and holding on the cursor’s dashed line with the mouse and moving it to a new position. 
 
ICP:  Check this box if you are taking data using an ICP sensor.  Leave this box unchecked if 
the sensor is non-ICP (ie. the sensor has its own power source). 
 



7 
 

 Page 7

23151 Alcalde Drive, Suite B-3 
Laguna Hills, CA 92653 
 

TEL:  (949) 363-2905 
FAX:  (949) 340-9751 

Sensitivity (V/EU):  Enter the sensitivity of your sensor here to record accurate data.  A sensor’s 
sensitivity can be found in the sensor’s documentation.  Be sure to use V/EU units.  Check that 
you have the accurate units and, if not, perform conversion prior to entering the value.  The 
sensitivity value will be recorded with the data. 
 
Label:  Enter a Label for the Input’s trace on the Display Graph.  This label will be recorded 
with the data.  It is recommended to use the label to indicate the sensor being used, the axis being 
measured (if applicable), and the units selected. 
 

Using QuickSet 
A QuickSet function is included to allow you to save your Run Control and Input settings and 
load these settings later.  This will preserve your preferred testing configuration from day to day 
and will save the time and trouble of repeatedly entering your settings. 
 
To Save a QuickSet:  Once you have entered your preferred settings in the Run Control and 
Input sections, access the Quick Set menu and select Save Settings.  Select the preferred save 
location (the default location is the WaveCatcher folder) and enter the name of the QuickSet 
settings.  Choose a name which is relevant to the type of test that the settings will be used for in 
the future, for example “Vibration Test – Lab Floor - Acceleration”. 
 
To Load a QuickSet:  Access the Quick Set menu and select Load Settings.   Locate the desired 
QuickSet file, select it, and click Open.  This will automatically configure your settings and you 
will be prepared to start taking a test. 
 
 
Acquisition 
You can manipulate the display graph using the controls above the graph.  The same controls are 
provided for both the Horizontal and Vertical Axes. 
 
Sample Mode -  
Peak to Peak:  measures the change between peak (highest amplitude value) and trough (lowest 
amplitude value). 
Peak:  measures the change between peak (highest amplitude value) and zero value. 
RMS:  root mean square – the square root of the mean squared peak value. 
 
Analysis Mode -  
FFT:  fast Fourier transform 
PSD:  power spectral density 
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Draw Limit:  allows user to add lines to graph at specific amplitudes and frequencies.  This 
function is useful for adding allowable noise levels (based on instrument specifications) to 
graphs for comparison to actual noise levels.  Enter the frequency where the line should start in 
the Start Freq field.  Enter the noise level limit in the Limit field.  Adding additional entries will 
stop the previous Draw Limit and add a new one. 
 
Time Average:  changes the testing duration from number of averages to number of minutes.  
Enter the number of minutes you would like the test to run for.  Click the Time Average Enable 
check box to enable time averaging. 
 
Legend:  toggles the graph legend on and off.  Legend displays the trace labels in the upper  
right corner of the graph. 
 
 
Display Settings 
You can manipulate the display graph using the controls above the graph.  The same controls are 
provided for both the Horizontal and Vertical Axes. 
 
SCALE- 
Horizontal Axis:  Allows you to toggle between Linear and Log Scale. 
Vertical Scale:  Allows you to select linear magnitude (LinMag), logarithmic magnitude 
(LogMag), or decibel magnitude (dBMag). 
 
Autoscale:  Checking this box automatically sizes the axis to fit the data that is taken. 
 
Min:  Allows you to manually set the minimum value displayed for that axis.  NOTE:  You will 
need to uncheck the Autoscale box to manipulate Min setting. 
 
Max:  Allows you to manually set the maximum value displayed for that axis.  NOTE:  You 
will need to uncheck the Autoscale box to manipulate Max setting. 
 

 
Feedback 

 
Herzan welcomes your feedback!  Please let us know what we can do to improve our products.  
You can reach us at feedback@herzan.com or (949) 363-2905.   
 
We look forward to hearing from you! 
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Appendix A: 
Best Practices – Conducting a Site Survey 

 
♦ Ensure that you are not changing parameters between tests which you plan to compare.  

♦ The more averages that are taken, the more noise will be filtered out.  Taking more 
averages will ensure more accurate data. 

♦ For vibration testing, make sure the sensor is firmly coupled to the surface you would like 
to measure.  For light accelerometer heads, adhesive or wax may be required to ensure a 
firm coupling. 

♦ Beware of 60 Hz spikes in the data.  These are often related to electro-magnetic 
interference and can be an artifact of line noise.  If you notice significant 60 Hz spikes in 
your data, make sure your testing set-up is grounded properly and run the test again. 

♦ Narrow the frequency span of your test to achieve better frequency resolution.  If you are 
unsure of the frequency area of interest, start with a broad frequency range and narrow 
your focus based on results. 

♦ Significant resonances in one axis can often feed into other axes and appear in the data 
for other directions.  Measure multiple points in different locations to diagnose the 
phenomenon. 

♦ Noise levels change throughout the day, due to foot and street traffic, equipment running, 
and other causes.  It is recommended to run tests at different times of day to filter out the 
periodic noise. 

♦ When doing comparative measurements, eliminate as many variables as possible.  If 
possible, take the data simultaneously using identical sensors, with the sensors aligned. 

 


